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This brief guide provides examples in the APA style for 

information sources most commonly used by DMACC 

students. It should always be used in conjunction with 

the 6th edition of the Publication Manual of the 

American Psychological Association and information 

provided by DMACC instructors. Appropriate page 

numbers from the handbook are documented with 

each example in this guide. You may also want to visit 

the APA website at http://www.apastyle.org/. 

Finally, don’t forget—your librarians are always ready 

to help with citation questions! 

 

How can this guide help me? 

Any academic research project must include accurate 

documentation of the resources consulted. This means 

providing information about your sources so your 

reader can locate them. If you examine articles in 

research journals, you’ll notice that they always 

include a list of references, with publication 

information.  

Documentation in research projects has two basic 

features: 

1. References List: At the end of your paper or 

presentation, include a list of the resources you 

used. The list must be on a separate page at the 

end of your paper with the title “References” 

centered at the top of the page. Each entry, or 

citation, in the list provides information about the 

individual source. Citations are listed in 

alphabetical order, starting with the author’s last 

name. If a source has no author, the entry is 

alphabetized by title. Citations are double-spaced 

with hanging indents. There are specific rules for 

punctuation and italics in a References List, 

illustrated by the examples in this guide.  

2. In-Text References: Each time you refer to a 

source in the text of your paper, include the last 

name of the author or the first few words of the 

title of the source (enough to identify it in your 

list of References) and the publication date, as 

close to the paraphrase or quotation as possible. 

(See the section on In-Text References for 

examples.) These references lead your reader to 

the appropriate entry in your References List.  

Why do citation styles matter? 
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Formatting your paper 

Microsoft Word Desktop Versions 

What should my final paper look 

like? (21-59, 228-231) 

The APA Handbook recommends that all research papers 

adhere to certain formatting guidelines. Be sure to 

check with your instructor to verify these guidelines 

with his/her own preferences and requirements.  Use 

this document as a tool to create basic research papers.  

More complicated papers may require additional 

resources. 

 

All APA-style papers should include four major 

components: 

1. Title page 

2. Abstract 

3. Text 

4. References page 

 

General Formatting Guidelines 

 Type your paper on a computer and print it on 

standard, white 8.5x11-inch paper. 

 Double-space the text of your paper and use a 

legible font like 12-point Times New Roman. 

 Set the margins of your document to 1 inch on all 

sides. 

 Indent the first line of all body paragraphs by 1/2 

inch. 

 Include a header that includes the short title of 

your paper (no more than 50 characters) at the 

top left in all CAPITAL LETTERS, and page 

numbers at the top right on every page. 

 

 

See pages 41-59 of the APA Publication Manual for 

sample papers.  

 

How do I format my paper in 

Microsoft Word 2013/2016? 

Open a new Microsoft Word document  

A new document automatically appears when Word is 

opened. 

Create a new blank document  

1. Open Word 2013/2016.  

2. Single-click the Blank document option.  

Shortcut Option: Press <Ctrl> + <N>  in Microsoft Word 

to open a new blank document. 
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Formatting your paper 

Microsoft Word Desktop Versions 

Set your margins to 1 inch 

A margin is the empty space between a document’s 

contents and the edges of the page. Word’s default 

margins are 1 inch on each side of the page which is 

also the required margin for APA.  However, if the 

default is not 1 inch, you can easily adjust the margins.  

1. Click the Page Layout tab on the Ribbon and click 

the Margins button in the Page Setup group.  

 

A list of common page margins appears.  

2. For 1 inch margins, select the Normal margin 

setting.  

 

The margin setting is applied to the document.  

Note: This is the normal default for margin spacing in 

Word 2013/2016. 

Set your line spacing and indentation  

The default settings for 

Word 2013/2016 do not 

match the APA style 

requirements for line 

spacing and indentation, 

so you will need to make 

the following 

adjustments. 

1. Click the Home tab 

on the Ribbon and 

click the Line 

Spacing button in 

the Paragraph 

group.  

A. Change Indentation to 

First line by .5”. 

B. Change After spacing to 0pt. 

C. Change Line spacing to Double. 
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Formatting your paper 

Microsoft Word Desktop Versions 

Create your header 

In APA style, the short name of the paper should appear 

at the top left margin and the page number should 

appear at the top right margin on all pages.  Note that 

the header is slightly different on the title page, so 

those instructions are included here. 

1. Click the Insert tab on the Ribbon and click the 

Header button in the Header & Footer group.  

2. Select Blank (Three Columns) from the list.  

The Header editor appears at the top of your page. 

3. You only need the left and right fields, so click on 

the center column (where it says Type text) and 

press delete. 

4. Click in the left field and enter your short title (Up 

to 50 characters from your full title) in all capital 

letters. 

5. Click in the right field, then click the Page Number 

button in your Header and Footer Tools Design tab 

in the Ribbon. 

6. Select Current Position and Plain Number from the 

drop down options. 

 

 

Now we need to make an adjustment so your first page, 

the title page, will also have the words Running head: 

before your short title. 

7. In your Header and Footer Tools 

Design tab in the Ribbon, check the 

box for Different First Page. 

The header will go blank, note that 

the blue tab under the header now 

says First Page Header. 

8. Click the Header button in your Header and Footer 

Tools Design tab in the Ribbon and select Blank 

(Three Columns) from the list.  

9. Again, you only need the left and right fields, so 

click on the center column (where it says Type text) 

and press delete (same as step 3). 

10. Click in the left field and enter the words Running 

head: followed by your short title in all capital 

letters. 

11. Click in the right field, then click the Page Number 

button in your Header and Footer Tools Design tab 

in the Ribbon (same as step 5). 

12. Select Current Position and Plain Number from the 

drop down options (same as step 6). 

13. You’re finished!  Now press the Close Header and 

Footer button in the ribbon to return to 

your paper. 
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Title Page 

Microsoft Word Desktop Versions 

How do I format my title page? 

(23) 
APA style requires a separate title page for research 

papers, which includes the title of the paper, the 

author’s name, and the institution for which the paper 

has been written.  The title will be typed with mixed 

case letters, centered, and positioned in the upper 

half of the page. 

1. Type the title of the research paper at the top of 

the title page and press Enter. 

2. Type your name and press Enter. 

3. Type the name of the educational institution and 

press Enter. 

Center the text horizontally 

1. Highlight the text to be centered. 

2. Click the Center alignment button in the 

Paragraph group on the Home tab, or press Ctrl + 

E. 

Position the text vertically 

APA style says the title should be positioned in the 

upper half of the page.  Unless your instructor has 

given you other instructions, you can usually achieve 

this by placing 5-6 double-spaced lines above your 

title. 

Formatting the header on the title page 

The header on the title page includes the short title 

and the page number.  The title page also includes the 

words Running head:.  See Create your header on 

page 4 of this guide for instructions on formatting the 

header in Microsoft Word 2013/2016. 

When your title page is complete, press <ctrl><enter> 

to advance to the next page. 

Learning to be Information Literate in the Information Age 

A. Sample Student 

Des Moines Area Community College 

Running Head: LEARNING TO BE INFORMATION LITERATE                                         1 

Sample title page 

Make sure that you use the same font through-

out your paper, including your header and 

your References list. 

While not strictly APA format, some 

instructors will ask you to include a date on 

your title page. 
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Formatting your paper 

Microsoft Word Online 

What should my final paper look 

like? (21-59, 228-231) 

The APA Handbook recommends that all research papers 

adhere to certain formatting guidelines. Be sure to 

check with your instructor to verify these guidelines 

with his/her own preferences and requirements.  Use 

this document as a tool to create basic research papers.  

More complicated papers may require additional 

resources. 

 

All APA-style papers should include four major 

components: 

1. Title page 

2. Abstract 

3. Text 

4. References page 

 

General Formatting Guidelines 

 Type your paper on a computer and print it on 

standard, white 8.5x11-inch paper. 

 Double-space the text of your paper and use a 

legible font like 12-point Times New Roman. 

 Set the margins of your document to 1 inch on all 

sides. 

 Indent the first line of all body paragraphs by 1/2 

inch. 

 Include a header that includes the short title of 

your paper (no more than 50 characters) at the 

top left in all CAPITAL LETTERS, and page 

numbers at the top right on every page. 

 

 

See pages 41-59 of the APA Publication Manual for 

sample papers.  

 

How do I format my paper in 

Microsoft Word Online? 

Open your DMACC Webmail.  

Click on the “square” in the corner. (This is usually in 

the upper left-hand corner, but depending upon your 

browser may be in the upper right-hand.)  
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Single click the tile for Word 

 

 

 

 

 

 

 

 

 

 

Single click the New Blank Document tile 

Name your file 

Word Online will automatically save your file to 

your OneDrive account. However, it will simply call it 

“Document”, which is not very useful.  

1. Single click on  “File” 

2. Single click on “Save As” 

 

Formatting your paper 

Microsoft Word Online 
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3. Single click on “Save As” 

4. Give your file a name that makes sense.  

Formatting your paper 

Microsoft Word Online 

How do I open a file that already 

exists in Microsoft Word Online? 

Open your DMACC Webmail.  

Click on the “square” in the corner. Single click the tile 

for Word. (See pages 5-6 for illustrations.) Either select 

your document from the “Recent” list or click on “Open 

from OneDrive for Business”.  

 

 

Check “Replace existing file” to avoid having 

multiple files called “Document” 
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Formatting your paper 

Microsoft Word Online 

Set your line spacing and indentation  

The default settings for Word Online do not match the 

APA style requirements for line spacing and indentation, 

so you will need to make the following adjustments. 

1. Your margins will default to 1”. 

2. Click the “Page Layout” tab. 

3. Click the small arrow in the Paragraph group. 

4. Set “Spacing” both Before and After to 0.00”. 

5. Change “Line Spacing” to “Double”. 

6. Click “Ok”. 

 

 

Single click on “Edit Document.” Then, select 

“Edit in Browser.” 
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Formatting your paper 

Microsoft Word Online 

Create your header 

In APA style, the short name of the paper should appear 

at the top left margin and the page number should 

appear at the top right margin on all pages. Note that 

the header is slightly different on the title page, so 

those instructions are included in the next section. 

1. Click the “Insert” tab and click “Header and 

Footer”.  

2. Click in the left field and enter your short title (Up 

to 50 characters or 12 words from your full title) in 

all capital letters. Since you won’t be using the 

center field, you may adjust it to make more space 

for your short title. 

3. Click the Page Numbers button and then select the 

image with the page number in the upper right-

hand corner. 
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4. Click the Page Numbers button and then 

select the image with the page number in 

the upper right-hand corner. 

5. Click on “Edit in Word” to close the Header 

& Footer tools and return to your paper. 

 

Title Page 

Microsoft Word Online 

APA format requires that the header for your title page 

be formatted differently than the header for the rest of 

your document.  

1. On the far right-hand side, click on the word 

“Options”. Then select “Different First Page”. 

2. The header will go blank, note that the left side of 

the screen now contains “First Page” and “Other 

Pages”. The “First Page” is highlighted in blue to 

indicate it is the selected option.  

3. Click in the left header field and enter the words 

Running head: followed by your short title in all 

capital letters. The center field will not be used 

and can be made smaller to accommodate your run-

ning head. 

How do I format the header for 

my title page? (23) 
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 Title Page 

Microsoft Word Online 

APA style requires a title page, which includes the 

title of the paper, the author’s name, and the 

institution for which the paper has been written. The 

title will be typed with mixed case letters, centered, 

and positioned in the upper half of the page. 

1. Click on the “Home” tab and then select the 

Center alignment button in the Paragraph group. 

2. Type the full title of the research paper and 

press Enter. 

3. Type your name and press Enter. 

4. Type Des Moines Area Community College and 

press Enter. 

Position the text vertically 

APA style says the title should be positioned in the 

upper half of the page.  Unless your instructor has 

given you other instructions, you are generally safe 

by “guesstimating” this with 5-6 double-spaced lines 

above your title. 

How do I format my title page? 

(23) 

Learning to be Information Literate in the Information Age 

A. Sample Student 

Des Moines Area Community College 

Running Head: LEARNING TO BE INFORMATION LITERATE                                         1 

Sample title page 

Make sure that you use the same font through-

out your paper, including your header and 

your References list. 

While not strictly APA format, some 

instructors will ask you to include a date on 

your title page. 
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Abstract and Body  

The abstract is a brief summary of the research paper 

and is typically 150-250 words. 

The abstract should be on page 2 of your paper and 

include: 

 The paper header (See Create your header on page 

5 of this guide for instructions in Microsoft Word 

2013.) 

 The label Abstract centered at the top of the page. 

 A single paragraph without paragraph indentation, 

left-aligned. 

When you complete your abstract, press <ctrl><enter> 

to advance to the next page.  

 

 

 

 

 

The body of the paper, or the content of the paper 

should start with the title of the paper centered at the 

top with the rest of the content double-spaced with 

first-line indented paragraphs.  See Set your line 

spacing and indentation on page 3 for instructions in 

Microsoft Word. 

How do I format my abstract? (25

-27) 
Abstract 

An abstract is a summary of your research paper. It should be about one para-

graph in length. An abstract is a summary of your research paper. It should be 

about one paragraph in length. An abstract is a summary of your research paper. 

It should be about one paragraph in length. An abstract is a summary of your 

research paper. It should be about one paragraph in length. An abstract is a 

summary of your research paper. It should be about one paragraph in length.  

LEARNING TO BE INFORMATION LITERATE                                                                       2 

How do I format the body of my 

paper? (42-59) 

Learning to be Information Literate in the Information Age 

          Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research 

text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research 

text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research 

text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research 

text Research text Research text Research text Research text Research text 

Research text (Baldwin, 2007). 

          Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research 

text Research text Research text Research text Research text Research text 

Research text. Research text Research text Research text Research text Research 

text Research text (Levin, Kater, & Wagoner, 2006). Research text Research text 

Research text. 

          Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research 

LEARNING TO BE INFORMATION LITERATE                                                                       3 

When typing your Abstract, you should change 

the indentation to “none”. See page 3 for 

information on adjusting the indentation.  

When you finish your abstract, be sure to 

change your indentation back to indent the 

“first” line by .5” 
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In-Text References 

What are in-text references and 

how do I use them? (174-179) 

Within the text of your paper, you must show your 

reader exactly what you borrowed from each source you 

paraphrase or quote, and exactly where in the source 

you found the material. These are your in-text, or 

parenthetical, references.  

 

Your in-text references must clearly point to sources in 

your References list, except in the case of personal 

communications (discussed later). Usually the author's 

last name and the publication date is enough. In some 

cases, such as when citing from a book, you will need to 

include page numbers as well. If a source has no author, 

use the title, shortened or in full. 

 

The following original passage is from the book 

Research Strategies, 5th edition, page 19 by William 

Badke, published in 2014 by iUniverse.  The examples 

show different types of in-text references. 

 

Citation 

 

Badke, W. (2014). Research strategies. Bloomington, IN: 

iUniverse. 

 

 

 

Direct Quotation: 
 

"When Dorothy from the Wizard of Oz discovered she was now 

in the Land of Oz, she told her dog Toto, ‘We’re not in Kansas 

anymore.’ If you’ve recently come into (or come back to) 

education, one of the first things to recognize is that this 

isn’t Kansas, this is Academia. It has new rules, new players, 

new sources of information and new ways of doing 

research" (Badke, 2014, p. 19). 

Paraphrase with the author’s 
name in the text: 
 

Badke (2014) makes the analogy that, like when Dorothy 

discovered she had arrived in the land of Oz, this is not 

Kansas anymore. This is Academia, and everything has 

changed (p. 19). 

Paraphrase with the author’s 
name in the parenthetical 
reference: 
 
Much like when Dorothy discovered she had arrived in the 
Land of Oz, this is not Kansas. This is Academia, and 

everything has changed (Badke, 2014, p. 19). 

Direct quote with the author’s 
name in the text: 
 

Badke (2014) goes on to say “one of the first things to 

recognize is that this isn’t Kansas, this is Academia. It has 

new rules, new players, new sources of information and new 

ways of doing research" (p. 19). 

Examples: 
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In-Text References 

References with six or more 

authors: 
 
When you are citing or paraphrasing a work with more than 

seven authors, you should list the last name of the first 

author, followed by “et al.”, the copyright date, and the 

appropriate page number. 

 

“Evolution depends on the creation of new genes, as well as 

on the modification of those that already exist” (Alberts et 

al., 2008, p. 253). 

Indirect reference: 
 
Sometimes, you will need to refer to an indirect quotation, 
that is, something that was itself a quotation in one of your 
sources. In this case, put the phrase “as cited in” before the 

reference.  

Joan London wrote of her father, Jack, “His longing for his 
daughters was deep and true, his need for them was 
desperate. But did anyone ever bungle more badly in trying to 

realize that desire? (as cited in Labor, p. 336). 

This could also be written with both sources listed in the text. 

Labor cites Joan London as saying of her father, Jack, that 
“his longing for his daughters was deep and true, his need for 

them was desperate” (p. 336) . 

 

You should only include the book, article or Web site 
that you actually have on your References page. In 
this example, Joan London would not be included on 

the References page. 

 

APA discourages the use of indirect quotations. They suggest 
that whenever possible, you should attempt to acquire the 

original document.  

 

Labor, E. (2013). Jack London: An American life. New 

York, NY: Farrar, Straus & Giroux.  

Reference with no author: 
 

When a source does not include an author, it is necessary to 

refer to it in your text by the full title (if short), or the first 

few words of a longer title. Begin with the word by which the 

source is alphabetized in your References list. 

 

For example, a quote from the entry “Plagiarism” from 

Wikipedia might read: 

“Within academia, plagiarism by students, professors, or 

researchers is considered academic dishonesty or academic 

fraud, and offenders are subject to academic censure, up to 

and including expulsion” (Plagiarism, 2014).  
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In-Text References 

References to personal communications (179) 
 

In APA style, the list of references includes information about recoverable data only. Personal communications are not 

recoverable by your reader, so they are cited only in the text of your paper. When you refer to a personal interview, a 

phone conversation, or other personal communication, give the initials and last name of your source, a descriptive 

phrase describing the communication, and as exact a date as possible. For example: 

 

According to librarian P. Mumma (personal communication, September 17, 2014), students can get help finding 

information for research projects in several ways. 

 

DMACC students can get help for research projects in person, by phone, email, or from the library website (P. Mumma, 

personal communication, September 17, 2014). 
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DOI 

What is a DOI? (188-192) 

DOI stands for Digital Object Identifier. It is a string of numbers and letters that serve as a permanent “address” to digital objects 

such as journal articles. URLs (web addresses) are constantly changing, and are, therefore, not a particularly effective way to 

relocate digital information. Since DOIs never change, they should always lead users back to the original document. Using a DOI 

instead of a URL in a reference list prevents users from encountering broken links and dead ends when recovering sources from a 

reference list. 

DOI is administered by the International DOI Foundation. Individual documents (articles and sometimes books) are assigned DOIs by 

the publisher at the time of publication. Once assigned, they will never change. A DOI will link readers directly to the object in 

question (or information about how to access the object) no matter where the object currently resides or how many times it has 

been moved. DOIs are also independent of database vendors, meaning that if an individual article or journal is indexed in multiple 

databases, it can be retrieved in all of them using the same DOI. 

CrossRef.org is a website that helps researchers and students check existing and locate missing DOIs. Use their website 

(www.crossref.org) to look up a DOI for an article, to verify an article’s DOI, or to find an article using its DOI.  

In APA references lists, DOI takes the place of changeable resource information (such as URLs). It eliminates the need for retrieval 

dates. Use DOI information whenever available, both for electronic resources and print resources.  

If you have questions about DOIs, or what to do if your source does not include this information, you may contact a DMACC 

librarian for assistance.  
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References Page 

The References page includes an alphabetical list of the 

sources you cited in your paper.  The References 

section of this guide provides examples of how to 

format citations for books, articles, DMACC Library 

Databases, and Web Sites.  You can also see the Using 

Citation Tools section of this guide for instructions on 

how to build a References page in NoodleTools or 

Microsoft Word. 

The page layout of your References page uses the same 

1 inch margins, double-spacing, and header as the body 

of the paper.  However, the page should be titled 

References, and the individual citations will use a 

hanging indent. 

Create a hanging-indent in Microsoft Word 2013 

1. Place your cursor on the first line after the title, or 

highlight your citations if they are already typed. 

2. Click the Home tab on the Ribbon and click the 

Line Spacing button in the Paragraph group.  

3. Click Line Spacing Options.  

4. In the Indentation area, select Hanging by .5” 

under Special. 

 

 

 

5. Press OK. 

How do I format my References 

page? (37, 180-183) 

What is a References page? (37) 

The Publication Manual of the American Psychological 

Association states: 

References acknowledge the work of previous 

scholars and provide a reliable way to locate it. 

References are used to document statements 

made about literature, just as data in the 

manuscript do not need to be exhaustive but 

should be sufficient to support the need for 

your research and to ensure that readers can 

place it in the context of previous research and 

theorizing. 
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Sample References Page 

References  

Bennett, K. K., Behrendt, L. S., & Boothby, J. L. (2011). Instructor perceptions of 

plagiarism: Are we finding common ground? Teaching of Psychology, 38(1), 29-35. 

doi:10.1177/ 0098628310390851 

Cvetkovic, V. B., & Anderson, K. E. (Eds.). (2010). Stop plagiarism: A guide to 

understanding and prevention. New York, NY: Neal-Schuman. 

Plagiarism prevention: A guide for students. (2012). Retrieved August 16, 2012, from 

http://www.deltastate.edu/ pages/ 1268.asp 

Youmans, R. J. (2011). Does the adoption of plagiarism-detection software in higher 

education reduce plagiarism? Studies in Higher Education, 36(7), 749-761. 

doi:10.1080/ 03075079.2010.523457 
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Books 

How do I cite a book with one 

author? (203) 

 
Morest, V. S. (2013). Community college student 

success: From boardrooms to classrooms  

Lanham, MD: Rowman & Littlefield. 

 Author's or editor's name (last name, initial(s)),  

 Year of publication, in parentheses 

 Title of the book (italicized). Capitalize the first 

word in title and subtitle and all proper nouns. 

 City of publication 

 Only include the state if the city is not easily 

recognized 

 Name of the publisher 

                                                                                                                                                                                                                        

It’s usually best to take this information from the title 

page of the book (front and back) rather than the 

cover. 

 

Sometimes, you need to include additional 

information, such as the edition of the book or the 

specific pages you are citing. 

What pieces of information do I 

need to cite a book? (202-205) 

How do I cite a book with two to  

seven authors? (184, 202) 

 
Satel, S. & Lilienfeld, S.O. (2013). Brainwashed: The 

seductive appeal of mindless neuroscience. New 

York: Basic. 

How do I cite a book with seven 

or more authors? (184, 198) 

 
Author A. A., Author B. B., Author C. C., Author D. D., 

Author E. E., Author F. F., ... Author J. J. (Year). 

Title of work. Location: Publisher.  
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Books 

How do I cite a book with one 

editor? (202) 

 
Ruan, K., (Ed.). (2013). Cybercrime and cloud forensics: 

applications for investigation processes. 

Hershey, PA: Information Science Reference. 

How do I cite a book with two to 

six editors? (184, 202) 

 
Baepler, P., Brooks, D. C. & Walker, J.D. (Eds.). (2014). 

Active learning spaces. San Francisco, CA: 

Jossey Bass. 

How do I cite a book with a 

corporate author? (184, 202) 

 
American Association of Community Colleges. (2003). State-

by-state profile of community colleges. (6th ed.). 

Washington, DC: Community College Press. 

How do I cite a multivolume 

work? (204) 

 
English, F. W. (Ed.). (2006). Encyclopedia of educational 

leadership and administration. (Vols. 1-2). 

Thousand Oaks, CA: Sage. 

Note: Use this format only when you used two or more 

volumes and you want to cite the entire work. 

How do I cite a second or later 

edition of a book? (203) 

 
Badke, W. (2014). Research strategies. (5th ed.). 

Bloomington, IN: iUniverse. 

How do I cite an electronic 

version of a book? (203) 

 
Mortenson, G. (2009). Stones into schools: Promoting peace 

with books, not bombs, in Afghanistan and 

Pakistan [Adobe ePUB version]. Retrieved from 

http://wilbor.lib.overdrive.com  
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Books 

How do I cite a book chapter? 

(204) 

 
McClenney, B. (1997). Launching a learning college. In T. 

O’Banion (Ed.), A learning college for the 21st 

century (pp. 211-224). Phoenix, AZ: Oryx Press.  

 

How do I cite part of an edited 

book (anthology or collection)?

(204) 

 
Johnson, L. L., & Carpenter, K. (2000). College reading 

programs. In R. F. Flippo, & D. C. Caverly (Eds.), 

Handbook of college reading and study strategy 

research (pp. 321-363). Mahwah, NJ: Laurence 

Erlbaum. 

Note: This entry includes the page numbers of the chapter  

or section cited. 

How do I cite an online 

encyclopedia entry? (205) 

 
Community college. (n.d.). In Merriam-Webster's online 

 dictionary. Retrieved from http://www.merriam-

 webster.com/dictionary/community college 

How do I cite an encyclopedia 

entry? (204) 

 
O'Banion, T. U. (2006). Community college. In World book 

encyclopedia (Vol. 4, pp. 898-899). Chicago: World 

Book. 
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Articles 

How do I cite an article from a 

popular magazine? (200) 

 
Go, A. (2007, April 16). Using the two-year option. U.S. 

 News & World Report, 64-65. 

How do I cite a newspaper 

article? (200) 

 
Rossi, L. (2007, March 5). More high schoolers tackle college 

courses. The Des Moines Register, pp. 1A, 4A. 

Note: Precede page numbers for newspaper articles with p. 
(if the article is on one page), or pp. (if the article 
continues on another page). Note that the section number 
is included with the page number. 

How do I cite an online 

newspaper article? (200-201) 
 

Asimov, N. (2010, March 23). Community college students 

 protest at Capitol. San Francisco Chronicle. 

 Retrieved from http://www.sfgate.com 

 The author's name (last name, initial(s)) 

 Year and exact date (month or month and date) of 
publication, separated by a comma and placed in 
parenthesis 

 The title of the article. Capitalize the first word in title 
and subtitle and all proper nouns, such as names. 

 The name of the publication in italics 

 The volume number (if known), in italics; followed by 
the issue number in parenthesis. The issue number is 
not italicized 

 The page numbers of the article 

 The digital object identifier (DOI) assigned to the 
article, if available 
 
If no DOI is available, include the URL for the article 
publisher. Use this format: Retrieved from http://
www.xxxxxx (do not place a period at the end of the 
URL). 

What pieces of information do I need 

to cite an article? (186-187,198-202) 

Traditional popular materials include newspapers and 

magazines, such as The New York Times or Newsweek 

magazine. While these publications serve a very important 

purpose, instructors will often require students to use 

scholarly resources for their research projects. Journals are 

the most common place to find scholarly information. They 

include articles written by experts that are often reviewed 

and critiqued by other experts before they can be 

published.   

Scholarly versus popular: what’s the 

difference? 

A periodical is any publication that appears on a regular 

basis, such as a daily newspaper, a weekly or monthly 

popular magazine, or a scholarly journal published three or 

four times a year. Articles from periodicals are excellent 

resources for student research projects.  

What is a periodical? 
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Articles 

How do I cite an article in a 

scholarly research journal with 

DOI? (198-199) 

 
Gantt, A. (2010). Graduation rates of students in technical 

programs at an urban community college. 

Community College Journal of Research & 

Practice, 34, 227-239. doi: 

10.1080/10668920903504992 

 

Brewer, P. D., & Brewer, K. L. (2010). Knowledge 

management, human resource management, and 

higher education: A theoretical model. Journal of 

Education for Business, 85, 330-335. 

doi:10.1080/08832321003604938  

How do I cite a book review? 

(209) 

 
Hall, J. (2010). [Review of the book The creative 

community college: Leading change through 

innovation, by J. E. Roueche, M. M. Richardson, P. 

W. Neal, & S. D. Roueche]. Community College 

Review, 37, 285-287. Retrieved from http://

crw.sagepub.com/ 

How do I cite an article in a 

scholarly research journal 

without DOI? (199) 

 
Roksa, J., & Calcagno, J. C. (2010). Catching up in 

 community colleges: Academic preparation and 

 transfer to four-year institutions. Teachers College 

 Record, 112, 260-288. Retrieved from http://

 www.tcrecord.org 
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Articles 

How do I cite an article with no 

author? (200) 

 
Six sites meet for comprehensive anti-gang initiative 

conference. (2006, November/December). OJJDP 

News @ a Glance. Retrieved from http://

www.ncjrs.gov/html/ojjdp/

news_at_glance/216684/topstory.html 

How do I cite an article with 

two to seven authors? (198) 

 
Roksa, J., & Calcagno, J. C. (2010). Catching up in 

 community colleges: Academic preparation and 

 transfer to four-year institutions. Teachers College 

 Record, 112, 260-288. Retrieved from http://

 www.tcrecord.org 

Delgado García, A., & Oliver Cuello, R. (2010). A model of 

equitable and sustainable redistribution of 

knowledge. Educational Technology Research & 

Development, 58, 781-790. doi:10.1007/s11423-

010-9169-y 

How do I cite an article with 

more than seven authors? (198) 

 
Gilbert, D. G., McClernon, J. F., Rabinovich, N. E., Sugai, 

C., Plath, L. C., Asgaard, G., ... Botros, N. (2004). 

Effects of quitting smoking on EEG activation and 

attention last for more than 31 days and are more 

severe with stress, dependence, DRD2 A1 allele, 

and depressive traits. Nicotine and Tobacco 

Research, 6, 249-267. doi: 

10.1080/14622200410001676305 

How do I cite an online 

magazine article? (200) 

 
Miners, Z. (2009, December 9). 4 things you should know 

 about community college. U.S. News & World 

 Report. Retrieved from http://www.usnews.com 

Be sure to list all of the authors 

if your work has 2-7 authors. 

If you have more than 7 authors, list the first 

6 and the last one with ellipses in between. 
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DMACC Library Databases 

Citations for articles and other documents from subscription 

services databases will normally include the same 

information you would have in a citation to a print source, 

plus the document’s DOI information. You do not have to 

include information about which database you used to find 

the article, or when you first retrieved it. The basic 

elements of a citation for an online article include the 

following: 

 

 The author's name (last name, intial(s)) 

 The year of publication, in parenthesis 

 The title of the article. Capitalize the first word in title 
and subtitle and all proper nouns. 

 The name of the periodical (italicized) 

 The volume number (if known), in italics 

 The page numbers of the article 

 The digital object identifier (DOI), if available 

 If no DOI is included, use CrossRef (www.crossref.org) 

to try to look up the DOI information for the article.  If 

CrossRef yields no results, look up the website for the 

journal and include the URL in your citation. Do not 

look for the specific page containing the article; only 

include the journal’s main or home page. 

 

Note: Some databases will try to provide ready-made 

citations for their resources. Be cautious with these, as 

many are not up to date with the latest set of APA 

guidelines, and others often contain mistakes. 

What pieces of information do I 

need to cite an article from a 

database? (198-202) 

Is it a magazine, a journal, or a 

reference book? 

The DMACC databases provide information from a variety of 

sources, including magazines, journals and reference books. 

It’s important to distinguish which type of resource you are 

using.  

Books will often include words like Encyclopedia, Dictionary 

or Survey in the title. A publisher is almost always provided. 

Many times you may see an “ISBN”, which is a code for the 

book. You may see phrases like, “In The Encyclopedia of…” 

Most of the entries in the Credo Reference and Magill 

OnLiterature Plus databases are from books. 

Magazines and journal articles will not list a publisher. They 

will list a “source”, which is the name of the magazine/

journal. It will include a date of publication, which is usually 

listed as a month and year (August 2012). Generally, you will 

also see a volume and issue, which may be identified, or 

may look like a decimal number (132.7). On newer articles, 

you may also see something called a “DOI.” This information 

is important in creating citations using the APA format. 

Journal 

article 

Reference 

book 

Reference 

book 
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How do I cite an article from an 

EBSCOhost database (Masterfile 

Premier, Academic Search 

Premier, etc.)? 

 
Horton, D. (2009). Class and cleats: Community college 

 student athletes and academic success. New 

 Directions for Community Colleges, 2009(147), 

 15-27. doi: 10.1002/cc.374 

How do I cite an article from a 

Thomson Gale database 

(Academic OneFile)?  

 
Marcotte, D. E. (2010). The earnings effect of education at 

 community colleges. Contemporary Economic 

 Policy, 28(1), 36. doi: 10.1111/j.1465-

 7287.2009.00173.x 

DMACC Library Databases 

27 

How do I cite an article from a 

Proquest database (Des Moines 

Register)? 

 
Rodgers, G. (2012, August 10). Library offering 3 new 

literacy programs. Des Moines Register, pp. 1-

1. Retrieved from Des Moines Register 

database. 

How do I cite a report from the 

CQ Researcher database? 

 
Wright, S. W. (2000, April 21). Community colleges: 

 Should  they offer four-year degrees?. CQ 

 Researcher, 10, 329-252. Retrieved from CQ 

 Researcher database  

Note: This article has no DOI listed in the database and a search 

on CrossRef returned no results.  
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DMACC Library Databases 

28 

How do I cite an article from the 

Credo Reference database? 

 
Plagiarism. (2001). In Encyclopedia of ethics. 

Retrieved from Credo Reference database.  

How do I cite an article from 

Project MUSE? 

 
Dee, T. S. & Jacob, B. A.(2012). Rational ignorance in    

 education: A field experiment in student 

 plagiarism. Journal of Human Resources         

 4(2), 397-434. 10.1353/jhr.2012.0012 

 

How do I cite an article from a 

Facts on File database?  

 
Snodgrass, M. E. (2006). Catt, Carrie Chapman. 

 Encyclopedia of Feminist Literature. Retrieved 

 from American Women’s History Online database.  

  

How do I cite an article from 

JSTOR? 

 
Bizzell, P. (2009). Composition studies save the 

 world. College English. 72(2), 174-187. 

 dx.doi.org/10.1632/prof.2009.2009.1.94 

Note: This article has no DOI listed in the database, but a search 

of the article title and author in Crossref.org quickly produced 

one. 
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Web Sites 

Citations for web sites may include any or all of the following: 

 

 The name of the author, compiler, corporate author or 

editor of the work  

 The publication or update year, if known, in parenthesis (If 

there is no publication date, use the abbreviation n.d. in place 

of the year.) 

 The title of the document, in italics (capitalize only the 

first word of the title and any names of people or places) 

 The title of the page, if the document is part of a larger 

Web site 

 The retrieval statement giving the electronic address, or 

URL, of the site, with no period or other additional punctuation 

 

In reality, many websites will not include all of the information 

you would find in a print source or subscription database 

document. If you cannot find some of the information, cite 

what is available.  

 

 

What pieces of information do I need 

to cite a Web site? (187-192) 

How do I cite a general website? 
(187-192) 
 

American graduation initiative. (2010). Retrieved from 

American Association of Community Colleges 

website: http://www.aacc.nche.edu/Advocacy/

aginitiative/Pages/default.aspx 

Gilman, T. (2010, February 22). Combating myths about 

distance education. Retrieved from The 

 Chronicle of Higher Education website: http://

chronicle.com/article/Combating-Myths-About 

 Distance/64299/ 

Moltz, D. (2010, March 11). Crunch time for 2-year colleges. 

Retrieved from Inside Higher Ed website: http://

www.insidehighered.com/news/2010/03/11/acct 

DMACC academic skills guide. (2008). Retrieved from Des 

Moines Area Community College (DMACC) website: 

http://www.dmacc.edu/skillsguide/ 
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Web Sites 

How do I cite Wikipedia? (187-

192) 
Community colleges in the United States. (2008, September 

6). Retrieved March 30, 2010, from Wikipedia 

website: http://en.wikipedia.org/wiki/ 

Community_colleges_in_the_United_States 

Note: While using Wikipedia for basic information is often 

helpful, citing it on an academic research paper is  

generally not recommended. 

How do I cite a blog posting? 

(215) 

 
Meola, M. (2007, August15). Computing Wikipedia’s 

 authority [Web log post]. Retrieved from http://

 acrlog.org/2007/08/15/ 

 computing-wikipedias-authority 

How do I cite a podcast? (210) 

 
Long, S. A. (Interviewer), & Mathews, B. (Interviewee). 

 (2010, March 17). Longshots #222: From solitary to 

 social: Creating an academic library for the whole 

 student [Audio podcast]. Retrieved from http://

 www.librarybeat.org/longshots/play/222 

How do I cite an online video? 

(209)  

 
xplanevisualthinking. (2009, September 14). Did you know 

 4.0 [Video file]. Retrieved from http://

 www.youtube.com/watch?v=6ILQrUrEWe8 

How do I cite presentation 

slides found online? (209-210) 

 
Stevens, A. (n.d.). Getting a new sequence of behaviors to 

occur with behavioral chaining  [online slides]. 

Retrieved from http://www.dmacc.edu/

instructors/acstevens/291pptsLinks.htm 

How do I cite a government 

document found online? (216-

224) 
Proclamation. No. 8480, 75 Fed. Reg. 10161 (2010), http://

 www.gpoaccess.gov/fr/. 

Note: This document is a presidential proclamation 

retrieved from GPO Access, a free online government 

database. 

 

No Child Left Behind Act of 2001, 20 U.S.C. § 1-6, http://

 www.gpoaccess.gov/plaws/index.html. 
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Citation Tools 

What is a Citation Tool?  

Citation tools are software programs designed to perform part or all of the tasks involved in creating academic 

citations. Most tools are capable of at least creating your References page at the end of your paper. Some can also 

assist you with your in-text references. A few can even help you manage and organize your resources. 

 

 

 

 

 

 

Should I Use a Citation Tool? 
 

This is a complicated question. While citation tools 

certainly make the process easier, most individuals 

acknowledge that there is value in learning not only the 

pieces of a written citation, but also how it is 

constructed. 

 

Many DMACC instructors want their students to have 

the opportunity to learn how to construct a written 

citation. These instructors do not allow the use of 

citation tools, and require that students create their 

own citations.  

 

Other instructors, particularly in more advanced 

classes, believe that their students have already gained 

this foundational knowledge of how to construct a 

citation. These instructors typically see the use of 

citation tools as somewhat equivalent to using a 

calculator in a higher level math class. These 

instructors are typically “ok” with the use of a citation 

tool, as long as the student’s References list is 

correctly formatted. 

Can My Instructor Tell If I Used a 

Citation Tool? 
 

This depends a bit upon how the class is formatted. If 

you are simply submitting a final draft of a paper, all 

your instructor will see is whether or not your citations 

are correctly formatted. However, not all citation tools 

are particularly accurate, and instructors can always do 

an in-class test of your citation knowledge and creation 

skills. 

How Accurate Are Citation Tools? 
 

This is also a complicated question. Some of the 

citation tools are capable of producing highly accurate, 

detailed citations, provided that the information you 

enter is also accurate. Some citation tools are limited 

in the types and/or complexity of the citations they can 

produce. Many citation tools are poorly programmed 

and are incapable of producing accurate citations.  

 

Ultimately, each student is responsible for the work 

he/she turns in. You should always double check your 

citations for accuracy and completeness.  
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Citation Tools 

Which Citation Tool Should I Use? 

There are literally hundreds, maybe thousands, of 

citation tools available. Many are free; some require 

purchase or an on-going fee. Some tools have less 

powerful (and sometimes less accurate) free versions, 

as well as “upgraded” fee-based versions. Some 

instructors will tell you to use their favorite citation 

tool. In the end, you should use the tool that best 

meets your needs. In addition to helping you create 

citations the “old fashioned” way, the Library is able to 

assist you with both NoodleTools. For assistance with 

other citation tools, you will need to consult with your 

instructor or contact the service directly.  

NoodleTools 

NoodleTools is the preferred citation tool of most 

DMACC researchers. As long as the information entered 

into the NoodleTools form is accurate, the software will 

produce an accurate citation. NoodleTools asks the user 

to complete a form for each resource. These forms are 

then converted into a properly formatted References 

list. While the NoodleTools knowledge base has 

extensive advice and information on how to properly 

construct in-text references, the software itself is only 

capable of producing the References list, which is 

placed at the end of a paper. 

 

Mendeley 

Mendeley is more of a source manager than a citation 

tool. It offers the most robust citation tool currently 

available. As a result, it is probably best suited for 

advanced users, who are collecting, storing and 

organizing large numbers of documents. In addition to 

producing highly accurate, detailed citations, Mendeley 

offers a Microsoft Word plug-in which fully integrates 

into Word 2013. This plug in corrects nearly all the errors 

produced by the “basic” Microsoft Word Citation Manager. 

This eliminates the need for the corrections listed at 

the end of this document. Mendeley can also save most 

citation data directly from library databases, Web sites, 

etc. Mendeley can be accessed at                               

http://www.mendeley.com and does require the 

installation of a desktop application. Up to 2Gb of 

information can be stored for free. Additional storage is 

available for purchase. 

Microsoft Word Citation Manager 

Some DMACC users prefer the ease of an integrated 

citation tool, like the Microsoft Citation Manager. The 

data form for recording sources can be clunky, and 

Microsoft doesn’t always follow the rules. This means 

that citations need to be corrected before submitting 

them for a grade. Many students find this process 

confusing and stressful. (A list of required corrections is 

available from the Urban library.)  
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NoodleTools 

What is NoodleTools?  

NoodleTools is an online tool that can help you format your bibliography page and allows you to save and organize 

the references for books and articles used for your research assignments. It is accessible from home and campus 

through the DMACC library website. For further assistance, contact a DMACC librarian.  

You need to access NoodleTools through the 

DMACC library website. Click on the link for 

“Research Help”. Then, select “Citations”. 

A new tab will open on your screen. Click on 

the icon for NoodleTools. 
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NoodleTools 

If you have never used NoodleTools, you will 

need to “Register” to create an account.  

 

 

 

 

 

 

 

 

 

 

Complete the registration form, create a 

Personal ID (username) and password. You may 

use anything you would like for your username, 

as long as someone else hasn’t already selected 

it. We recommend using your DMACC username 

and password. 

 

 

 

 

If you forget your username/password, 

please see your campus librarian.  
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NoodleTools 

Once you have created your Personal ID, you can 

start entering references by creating a new 

project. Each research project you are working 

on should have its own list. Start by clicking on 

the “New Project” button at the top left-hand 

side of the page.  

Next, name your project. Select “APA” for the 

“Citation style” and “Advanced” for the 

“Citation level”. Click “Submit” at the bottom 

of the box to get started.  

You may name your project 

anything you like, but we 

recommend that you include the 

topic of your project, the course 

and semester. E.g. Stress 

Management PSY111 Spring 

2017. 
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NoodleTools 

The next screen is called the Dashboard. Here 

you can work on many aspects of your project: 

your thesis statement, your research question(s). 

You can also share your project with a teacher or 

librarian to receive assistance and/or feedback.  

You can set up and maintain a “To Do” list of 

tasks you still need to complete for your project. 

You can use NoodleTools to create digital 

notecards and your outline.  

You will primarily use NoodleTools to create your 

Reference list for your project. You may begin by 

clicking “Sources” at the top of the screen. 

 

 

Once you have clicked on “Sources”, you are 

ready to begin entering the information for each 

of your sources. 

Create a citation for each source by clicking 

“Create New Citation” in the upper left-hand 

corner. 

While NoodleTools provides a link to 

Google Docs, we recommend that you use 

Microsoft Word to write your paper. Word 

is available on all DMACC computers. 

Students can also access Word Online for 

free through their Webmail.  
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NoodleTools 

 

First, select where you located your resource. 

For most DMACC students, this will usually be 

either “Database” or “Website”. 

 

 

 

 

Then, select what the item is. 
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NoodleTools 

 

 

Complete the form with the available 

information for your resource. If you decide you 

have selected the incorrect resource type, you 

may make changes from the drop down boxes at 

the top of the screen. 

As you select each text box, NoodleTools 

will give you instructions for the correct 

entry of your data. If you make a 

mistake, NoodleTools will display an 

exclamation point inside of a yellow 

triangle. 



 

 39 Updated: 1/17 

 

Once you have clicked on “Submit” to complete a 

resource, NoodleTools will return you to the main 

References screen. To enter another resource, simply 

select the resource type from the drop down and begin 

the process again. 

Once you have reached the main References 

screen, your work has already been saved to 

the NoodleTools server. Please do not try to 

save your work to an another source. (e.g. a 

flash drive, your p:\ drive, etc.) 

After you have entered all of your sources and 

completed your paper, review each of your citations on 

the main References page for errors. You can edit your 

citations by clicking the “Options” button on the right-

hand side of the screen. 

NoodleTools 
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NoodleTools 

Finished? Now print your References Page 

 

 

To print your References page, click the “Print/

Export” button and then select “Print/Export to 

Word” 

  

 

 

 

 

 

 

 

 

Once you see the pop-up for Microsoft Word, 

click “Ok”. Your References page will open in a 

new Microsoft Word window. 
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NoodleTools 

NoodleTools will always open your References in 

Times New Roman, 12pt font. Double check and 

make sure that the font matches what’s on the 

rest of your paper. Also, be sure to add a header 

with your name and the correct page number. 

Please see a DMACC librarian if you need help 

with getting the correct page number added. 

Since NoodleTools saves your work to their 

server, and keeps track of any changes to 

your list, we recommend that you wait and 

print your References at the very end of 

your project. This will help eliminate 

confusion and mistakes between what you 

may have saved and what NoodleTools has 

saved.  
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